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SUMMARY: 
This study effectively accomplished the automated classification of two distinct categories by acquiring cough sound data from patients diagnosed with chronic obstructive pulmonary disease (COPD) and respiratory tract infections (RTI), utilizing an integration of speech signal processing techniques and machine learning algorithms.

ABSTRACT: 
The objective of this study was to develop and evaluate a non-invasive method for distinguishing patients with chronic obstructive pulmonary disease (COPD) from those with respiratory tract infections (RTI) using voice signal analysis and machine learning. Fixed-pattern voice signals were collected from 25 COPD patients and 25 RTI patients (serving as the control/comparison group). Multi-dimensional voice feature analysis was performed to identify features significantly differentiating the two groups. Statistically significant features were selected and subjected to dimensionality reduction. Logistic Regression (LR) and Random Forest (RF) models were then trained and evaluated for classification performance in distinguishing COPD from RTI. Over 400 voice features were initially analyzed. Eighteen features showed highly significant differences between COPD and RTI patients (P < 0.05). In the task of distinguishing COPD patients from RTI patients, the LR model achieved a test set area under the curve AUC of 0.95, significantly outperforming the RF model (AUC = 0.76). This study demonstrates the feasibility of using voice analysis and machine learning, particularly the LR model, as a promising non-invasive tool for differentiating COPD from RTI. It provides a foundation for the practical application and further optimization of this voice-based approach in clinical settings requiring differential diagnosis of respiratory conditions.

INTRODUCTION: 
Chronic obstructive pulmonary disease (COPD) and respiratory tract infections represent significant contributors to mortality and morbidity on a global scale. COPD is defined as a chronic inflammatory condition affecting the airways and lung parenchyma, predominantly induced by smoking. It is characterized by symptoms such as persistent cough, dyspnea, and increased sputum production1. The World Health Organization projects that by 2030, COPD will rank as the third leading cause of death worldwide, imposing a substantial economic burden2,3. In contrast, respiratory tract infections (RTI) account for approximately 6% of the global disease burden, surpassing the burden associated with ischemic heart disease, HIV infection, cancer, malaria, and diarrheal diseases4.

Due to the substantial similarities in the clinical manifestations of the two diseases, particularly in the symptomatology of cough, which is a prevalent symptom, early and precise differentiation between these diseases is essential for effective treatment5,6. Traditional diagnostic approaches predominantly depend on clinical symptom assessment, lung function testing, and laboratory analyses7. While conventional diagnostic methods for COPD are effective in identifying and evaluating the condition, they exhibit several limitations in clinical practice. These limitations include inadequate diagnostic accuracy, limited capacity for early diagnosis, insufficient understanding of disease heterogeneity, and a lack of dynamic monitoring8–11. In contrast to traditional diagnostic methods for COPD, voice diagnosis technology, as an emerging auxiliary tool, offers numerous advantages, particularly in early detection, non-invasive diagnosis, and dynamic monitoring.

With advancements in speech analysis, particularly the automated analysis of cough sounds, there is emerging potential for rapid diagnostic applications. Research indicates that cough sounds encapsulate extensive information regarding pulmonary diseases, with their acoustic features reflecting alterations in airway health status12. Recently, machine learning-based techniques for speech feature analysis have been employed in diagnosing COPD and other conditions, yielding notable outcomes13–15. These methodologies facilitate the effective classification of diseases by extracting audio features from cough sounds, such as frequency, duration, and amplitude, and integrating them with machine learning algorithms for pattern recognition. 

Despite some studies investigating the potential of cough sound analysis in disease diagnosis, significant challenges persist in differentiating between COPD patients and those with RTI. This difficulty arises due to overlapping characteristics in the cough sounds of both groups, compounded by individual variability. Consequently, the development of methods to extract more precise and distinguishable features from cough sounds remains a critical issue in this domain.

This study seeks to investigate an automated classification method for cough sounds by recording audio from 25 patients diagnosed with COPD and 25 patients with RTI. By integrating speech feature analysis with machine learning algorithms, we aim to enhance the accuracy of disease differentiation, thereby improving early diagnostic capabilities for COPD and RTI.

PROTOCOL: 
The Ethics Committee of Beijing University of Chinese Medicine and its Third Affiliated Hospital approved this research study. All participants provided their written informed consent to participate. Between July and August 2024, a cohort of 25 COPD patients was recruited from the Respiratory Medicine Department at the Third Affiliated Hospital of Beijing University of Chinese Medicine. Simultaneously, a control group consisting of 25 patients with typical upper RTI was also assembled.

1. Participant selection

1.1. Inclusion criteria

1.1.1. Select the audio samples with low background noise and clear articulation.

1.1.2. Ensure that a COPD diagnosis for the COPD group is mandated by clinical guidelines set by lung experts. 

1.1.2.1. Confirm diagnosis via post-bronchodilator spirometry (FEV₁/FVC < 0.70) per GOLD 2024 criteria.

1.1.2.2. Verify clinical stability (no exacerbations ≥ 4 weeks)

1.1.3. Ensure that the comparison group comprises people suffering from typical upper RTI.

1.1.3.1. Diagnose using the diagnostic criteria of the Diagnosis and Treatment Guidelines for Respiratory Infection Diseases. 

1.1.3.2. Ensure symptom onset time ≤ 72 h.

1.1.3.3. Exclude chronic respiratory disease history. 

1.1.4. Restrict age to 18–85 years.

1.1.5. Request that all participants provide written informed consent to participate in the study.

1.2. Exclusion criteria

1.2.1. Exclude participants who are experiencing speech difficulties, such as vocal cord disorders or laryngitis.

1.2.2. Exclude participants with neurological conditions that may impair speech or cognitive functions.

1.2.3. Exclude participants with significant hearing impairments.

1.2.4. Exclude participants who did not adhere to study protocols or failed to provide a sufficient number of audio samples. 

1.2.5. Exclude participants who are unable to provide informed consent.

2. Study design

2.1. Move the participants to a quiet, isolated standard clinical consultation room (4 m × 5 m dimensions), with external noise levels maintained below 30 dB. Have them sit in a natural, comfortable posture and remain in a relaxed state.

2.2. Meticulously document the essential details of the participant, including height, weight, age, and other relevant information, and confirm their current health status with a physician. 

2.3. Upon completion of the initial data recording, adjust the microphone's height to the appropriate position, ensuring a distance of approximately 20–30 cm between the microphone and the participant's lips. 

2.4. Collect the audio recordings using a professional portable handheld multitrack recorder, with the sampling rate uniformly set to 44.1 kHz. 

2.4.1. Perform the device calibration prior to daily recording sessions. Press and hold the GAIN knob of the target channel for 2 s until the screen displays CAL and the current level value. 

2.4.2. Adjust the gain to the target value by slowly rotating the GAIN knob until the input level shown on the screen precisely matches the nominal value of the test tone. Ensuring an error margin within ≤±1 dB.  

2.5. Under the guidance of the sampling team, let the participant naturally cough in accordance with their condition. Capture the cough sounds using recording devices. 

2.6. Record the audio as `.WAV` file format.

2.7. Abnormal audio segments were removed using voice activity detection (VAD) complemented by manual verification. Recordings that met the signal-to-noise ratio (SNR) threshold of >20 dB were included in the study.

NOTE: The full methodology is available in our GitHub repository (https://github.com/Liteng811/speech-feature-index-database-construction).

3. Development of the Vocal Feature Repository

NOTE: The voice feature indicator database is a collection of acoustic characteristics for comparative analysis of vocal patterns in COPD versus RTI. The methodological architecture is detailed in Table 1. An open-source codebase for its construction has been implemented and is accessible on GitHub (https://github.com/Liteng811/speech-feature-index-database-construction). The steps below detail the code's download and execution. 

3.1. Install MATLAB on the computer from the MathWorks official website (https://www.mathworks.com/). Ensure that the appropriate version for the operating system is selected. To verify that MATLAB is installed correctly, start the MATLAB software and type ver in the command window. If installed properly, the version information of MATLAB should appear.

3.2. Install Git from the official Git website (https://git-scm.com/). To confirm the successful installation, enter the following command in the command line (Command Prompt for Windows, Terminal for Mac/Linux): git --version. If Git has been installed successfully, the version information will be displayed.

3.3. Retrieve the Code Repository

3.3.1. Using a command-line interface, execute the git clone command to download the project files to your local machine:
git clone https://github.com/Liteng811/voice-feature-index-database-construction.git

NOTE: This operation creates a new directory named "voice-feature-index-database-construction" in your present working directory, containing all project files.

3.3.2. Access the downloaded folder to manage its contents by running:
cd voice-feature-index-database-construction.

3.4. MATLAB Environment Setup.

3.4.1. Start the MATLAB application.

3.4.2. Integrate the project folder into the MATLAB search path. Navigate to the Home tab, click Set Path, then Add Folder. Select the cloned voice-feature-index-database-construction directory and save the changes. This allows MATLAB to access all necessary scripts.

3.4.3. From the Current Folder panel in MATLAB, open the main processing script (voiceH6_batch_3_stage_WAV_tt.m) by double-clicking on it.

3.5. Data Preparation.

3.5.1. The analysis requires input audio files in .wav or .pcm format.

3.5.2. The paths to these audio files are hardcoded within the scripts. Update these path variables to point to the correct locations on the local system.

3.6. Script Execution.

3.6.1. With the main script (voiceH6_batch_3_stage_WAV_tt.m) open, initiate processing by either clicking the Run button or typing the script name directly into the MATLAB Command Window: voiceH6_batch_3_stage_WAV_tt.

3.6.2. The script necessitates user interaction. MATLAB will display a graphical interface prompting the user to choose the appropriate audio file or folder. Ensure that the audio file or folder selected for processing matches the prompt.

3.6.3. If issues with the graphical interface freezing or not displaying when running the script in MATLAB are encountered, verify potential compatibility issues with the MATLAB version or ensure that the operating system's graphics drivers are functioning properly.

3.7. Output the results. Upon completion, search for a .txt output file where the script will have written the feature extraction results. The output file will contain information such as the audio feature recognition results.

4. Data analysis

NOTE: Following the assembly of the vocal feature indicator database, statistical analyses were conducted. The analytical approach is outlined in Table 2. The Mann-Whitney U test was employed to assess differences in the voice signal features between the COPD and RTI groups.

4.1. Test for Mann-Whitney U.

NOTE: After obtaining the speech feature index library, the Mann-Whitney U test was performed on the data using SPSS 20.0. The operation process is as follows:

4.1.1. Open SPSS and load the data file. 

4.1.2. Select Analyze > Nonparametric Tests > Legacy Dialogs > 2 Independent Samples from the menubar. 

4.1.3. In the pop-up dialog box: 

4.1.3.1. Test Variable List: Select the variables to be compared (observed variables). 

4.1.3.2. Grouping Variable: Select the grouping variable (the variable that will be used for grouping). 

4.1.3.3. Click the Define Groups button to enter the identifiers of the two groups in the pop-up window (for example, if grouped as "Group 1" and "Group 2," enter 1 and 2). 

4.1.4. In the Test Type, select the Mann-Whitney U test partially. 

4.1.5. Click OK, and SPSS will automatically generate the output. 

4.2. Principal Component Analysis (PCA)

NOTE: Following the identification of statistically significant features, Principal Component Analysis (PCA) was employed for advanced data exploration. This technique reduces dimensionality by condensing the original variables into a smaller set of composite components that preserve critical information and simplify the interpretability of the dataset. Prior to performing PCA, the data were automatically standardized by the statistical software to mitigate scale-related biases. The procedure was executed as follows:

4.2.1. Ensure that the data has been collated, saved in Excel or CSV format, and imported into SPSS 20.0.

4.2.2. Select File > Open > Data, then select the file to open.

4.2.3. Ensure that the missing values and outliers in the data are handled, and that the variables are standardized.

4.2.4. For PCA analysis in SPSS, click Analyze > Dimension Reduction > Factor.

4.2.5. In the dialog box, add all the variables used in PCA to the Variables field. These variables are usually continuous data.

4.2.6. Set up the extraction method.

4.2.6.1. In the dialog box, click the Extraction button and select the Principal Components method. By default, SPSS extracts enough principal components to explain the variance in the data.

4.2.6.2. Select Eigenvalues greater than 1 as the retention criterion, meaning that only principal components with eigenvalues greater than 1 are retained, which usually explains most of the variance.

4.2.7. Select the rotation method and click Rotation to choose either Varimax (orthogonal rotation) or Promax (oblique rotation). For most applications, Varimax is a commonly used rotation method.

4.2.8. In the options, check the Scree plot and Coefficient matrix so that the gravel diagram of the principal components and the coefficient matrix of each principal component can be output to help judge the retained variance.

4.2.9. After setting all the options, click the OK button, and SPSS will generate the output.

4.2.10. Interpretation of the results.

4.2.10.1. Interpret the principal component loading matrix to identify relationships between principal components and original variables. Note that variables with higher load values require greater contribution to changes.

4.2.10.2. Explain variance using the "Total Variance Explained" table. Observe eigenvalues and variance proportions for each principal component. Select principal components with large variance proportions, as they typically explain most data variation.

4.2.10.3. Use the scree plot to determine retained principal components. Identify the clear inflection point in the plot. Retain principal components to the left of the inflection point.

4.2.10.4. Principal component scores: Check save as variables if the score for each sample on the principal component needs to be obtained, and SPSS will add the principal component scores to the dataset as new variables.

5. Building the Logistic Regression (LR) and Random Forest (RF) model

NOTE: The specific methodological framework for constructing LR and RF models is detailed in Table 3. Meanwhile, the LR and RF models in this study have been uploaded to GitHub (https://github.com/Liteng811/The-distinction-between-COPD-and-respiratory-infections). The following will primarily describe how to download and run the code from GitHub. The RF model was constructed using Python 3.12.3 as the primary programming language.

5.1. Obtain the project codebase.

5.1.1. Launch a terminal or command prompt and run the git clone command to download the repository locally:
git clone https://github.com/Liteng811/The-distinction-between-COPD-and-respiratory-infections.git

Note that this command retrieves all repository contents into your current working directory, generating a new folder titled The-distinction-between-COPD-and-respiratory-infections.

5.2. Set Up the Programming Environment.

5.2.1. Download and install Python from the official distribution site (https://www.python.org/).

5.2.2. Use the command below to install all Python dependencies listed in the requirements file: pip install -r requirements.txt.

5.2.3. If the requirements.txt file is unavailable, install the essential libraries manually by executing: 
pip install numpy pandas scikit-learn matplotlib

5.2.4. Install the PyCharm integrated development environment from the official JetBrains website (https://www.jetbrains.com/pycharm/).

5.3. Explore Repository Contents.

5.3.1. In the repository, locate the main script files (LR.py, RF.py).

5.3.2. Open these files using a code editor or PyCharm to review their implementation and structural details.

5.4. Prepare the input data.

5.4.1. Ensure that the required dataset is available in .xlsx format, as expected by the code, and properly organized before execution.

5.4.2. The code contains hardcoded file paths. Update these paths to reflect the actual locations of the files, effectively replacing the existing paths in the code (e.g., C:\Users\1\Desktop\pca-result.xlsx) with the actual file paths on the system.

5.5. Run the code.

5.5.1. Once the main script is located, execute it via the command line. For instance, to run LR.py, use: python LR.py
If the target script is RF.py, substitute the filename accordingly.

5.5.2. Before execution, ensure the terminal is in the correct working directory, or specify the full path to the script. For example: 
python C:/path/to/your/repository/LR.py.

5.5.3. During operation, the script will load the dataset, train the corresponding machine learning model (LR or RF), and generate performance metrics including accuracy, confusion matrix, and ROC curve.

REPRESENTATIVE RESULTS: 
Data analysis results
The research successfully isolated over 400 speech feature indexes using methods like time domain analysis, frequency domain analysis, extraction of Mel-frequency Cepstral Coefficient (MFCC), and altering feature indicators according to TCM diagnosis. Analyzing the time domain is a crucial element in speech signal processing, focusing on the direct manipulation of signal time series data to intuitively comprehend signal properties such as energy, overzero rate, linear trends and envelopes, autocorrelation studies, and amplitude modulation, among others16–20. Frequency domain analysis is the process of transforming a time domain signal into a frequency domain signal via the Fourier transform to examine the signal's frequency elements. The alteration reveals the signal's various frequency components in the spectrum, enhancing comprehension of its characteristics. Various methods for analyzing frequency domains encompass the short-time Fourier transform17, predicting in the frequency domain linearly, utilizing frequency domain scaling, and analyzing the base time-frequency of adaptive chirp17, 21–23. Furthermore, certain characteristic indicators underwent alteration in accordance with TCM diagnostic standards to more effectively align with the particular requirements and analysis aims of this research.

After completing the mentioned speech feature index library, the study continued with further differential analysis. If the P-value of Asymptotic Significance (2-tailed) is less than the set significance level of 0.05, the null hypothesis is rejected, indicating a significant difference between the two groups. If the P-value is greater than 0.05, the null hypothesis cannot be rejected, indicating no significant difference between the two groups. The study uncovered 18 substantial disparities (P < 0.05), possibly linked to the data regarding brief cough noises.

Post-PCA analysis, the index was excluded because calculating correlation coefficients for related variables proved unfeasible. After excluding this index, the PCA analysis showed a KMO value of 0.513 and a P-value below 0.01. Findings from the PCA demonstrated the derivation of six main parts, constituting 76.8% of the total variation, as shown in the following illustration. For the subsequent development of the model, calculations were made for principal component factor scores as shown in Figure 1 and Table 4. The definition of the features is shown in Supplementary File 1.

Model construction results
The original dataset was partitioned into a training set (80%) and a hold-out test set (20%). A stratified 3-fold cross-validation scheme was applied to the training set. Within each fold, the training data were further split into a training subset (80%) and a validation subset (20%). The training subset facilitated model learning, and the validation subset was reserved for hyperparameter optimization. After model tuning is completed, the independent test set is used to evaluate the generalization ability of the final model.

This research categorized COPD and RTI patients using both random forest and logistic regression models, with the random forest model attaining 80% accuracy and the logistic regression model showing 90% accuracy, as shown in Figure 2, Figure 3, Figure 4, Figure 5, Figure 6, Figure 7, and Table 5. The definition of the features is shown in Supplementary File 1.

Hyperparameter optimization was conducted using GridSearchCV with StratifiedKFold (n_splits=3) to ensure robust validation. The best-performing hyperparameters for the LR model were identified as C=1, penalty='l1', and solver='saga'; for the RF model, the optimal configuration included max_depth=None, min_samples_leaf=1, min_samples_split=5, and n_estimators=50.

The stratified cross-validation results are summarized in Figure 2 and Figure 3. The LR model achieved AUC scores of 0.71, 0.74, and 0.88 across the three folds, yielding a mean AUC of 0.77 with a standard deviation of 0.08. In comparison, the RF model produced AUC values of 0.69, 0.52, and 0.83, resulting in a lower mean AUC of 0.68 and a higher standard deviation of 0.13. These results indicate that the LR model not only exhibits superior predictive performance but also greater stability relative to the RF model.

The research went on to develop the confusion matrix and charted the various categorization ROC curves. As shown in Figure 4 and Figure 5, the data from the confusion matrix revealed that the RF model accurately classified 2 and 5 instances among 10 specimens for both COPD and respiratory diseases. Conversely, the LR model successfully forecasted 3 and 6 samples accordingly. 

As shown in Figure 6 and Figure 7, for the ROC curve evaluation, the Area Under the Curve (AUC) value for the LR model stood at 0.95. The RF model's Area Under the Curve (AUC) measure stands at 0.76. Among them, the RF model performs well on the test set, but performs poorly in cross-validation, which may indicate that the model performs well on the training set, but there may be some overfitting or inconsistent data distribution on the validation set.

FIGURE AND TABLE LEGENDS: 
Figure 1: PCA scree plot. The scree plot visualizes eigenvalues associated with each principal component. The horizontal axis (Component Number) indicates the index of each component in descending order of variance explained. The vertical axis (Eigenvalue) quantifies the amount of variance captured by each component. Individual markers correspond to the eigenvalue of successive components.

Figure 2: Three-fold cross-validation ROC curve – LR. The plot depicts the false positive rate (X-axis) against the true positive rate (Y-axis). The solid blue line represents the mean ROC curve across folds, and the dashed line indicates the performance of a random classifier. The LR model achieved a mean AUC of 0.77 (±0.08), reflecting relatively stable and discriminative performance. Abbreviations: ROC = receiver operating characteristic; AUC = area under the curve; LR = Logistic Regression.

Figure 3: Three-fold cross-validation ROC curve – RF. The plot depicts the false positive rate (X-axis) against the true positive rate (Y-axis). The solid blue line represents the mean ROC curve across folds, and the dashed line indicates the performance of a random classifier. The RF model yielded a mean AUC of 0.68 (±0.13), suggesting acceptable but more variable predictive capability. Abbreviations: ROC = receiver operating characteristic; AUC = area under the curve; LR = Logistic Regression; RF = Random Forest.

Figure 4: Confusion matrix – LR. Cell color intensity corresponds to the count of predictions, with darker shades indicating higher values. Each cell contains the number of instances classified for every actual-versus-predicted class combination. The LR model correctly identified 3 COPD cases and 6 RTI cases. Abbreviations: LR = Logistic Regression; COPD = Chronic Obstructive Pulmonary Disease; RTI = respiratory tract infections.

Figure 5: Confusion matrix – RF. Cell color intensity corresponds to the count of predictions, with darker shades indicating higher values. Each cell contains the number of instances classified for every actual-versus-predicted class combination. The RF model correctly identified 2 COPD cases and 5 RTI cases. Abbreviations: RF = Random Forest; COPD = Chronic Obstructive Pulmonary Disease; RTI = respiratory tract infections.

Figure 6: Test-set ROC curve – LR. The ROC curve for the LR model on the independent test set is shown, with the false positive rate on the X-axis and true positive rate on the Y-axis. The blue solid curve represents model performance, and the dashed line corresponds to random guessing. The AUC of 0.95 denotes excellent classification ability. Abbreviations: ROC = receiver operating characteristic; AUC = area under the curve; LR = Logistic Regression.

Figure 7: Test-set ROC curve – RF. The ROC curve for the RF model on the independent test set is shown, with the false positive rate on the X-axis and true positive rate on the Y-axis. The blue solid curve represents model performance, and the dashed line corresponds to random guessing. The AUC of 0.76 denotes excellent classification ability. Abbreviations: ROC = receiver operating characteristic; AUC = area under the curve; RF = Random Forest.

Table 1: Procedure for vocal feature extraction

Table 2: Data processing framework

Table 3: Model construction process

Table 4: Comparison of differentiated voice features between COPD and RTI patients (Median [Q1-Q3]). Abbreviations: COPD = Chronic Obstructive Pulmonary Disease; RTI = respiratory tract infections.

Table 5: Comparison of classification performance for LR and RF models in COPD and RTI groups. Abbreviations: LR = Logistic Regression; RF = Random Forest; COPD = Chronic Obstructive Pulmonary Disease; RTI = respiratory tract infections.

Supplementary File 1: Definition of the features shown in the figures.

DISCUSSION: 
This study investigates non-invasive methods for detecting COPD through voice signal analysis and machine learning techniques. It involved collecting voice data from 25 COPD patients and 25 patients with RTI. Models were constructed using LR and RF algorithms. Both models showed similar accuracy in correctly classifying samples overall, yet the difference in AUC values indicates that the LR model might offer a superior balance between sensitivity and specificity. The subsequent sections provide a detailed examination of the research outcomes.

The study shows that LR models achieved accuracy rates of 90% on the test set, while the RF model achieved 80%, with the LR model corresponding to an AUC value of 0.95 and the RF model corresponding to an AUC value of 0.76. This may be because the inherent simplicity of the LR model grants it stronger resistance to overfitting and greater robustness in small-data scenarios, enabling efficient utilization of the 18 key features for precise classification. Conversely, the complex structure of RF makes it prone to overfitting noise in the training set under limited data conditions, resulting in significant performance degradation when generalized to the test set.

Initially, managing the environment is vital when gathering data. Capturing the cough sounds in the tranquil consultation area prevents any external disturbances and guarantees the cough audio's sharpness and precision. Choosing and tweaking recording tools while sampling guarantees crisp cough sound signal quality, essential for later signal processing and feature extraction24. Nevertheless, bias might still exist because of the substantial individual variations in coughing sounds and the impact of patient mood and disease condition. Hence, upcoming research should take into account several recordings and collective data averaging to minimize individual variations influencing the analytical outcomes.

This research focused on extracting multi-dimensional speech attributes, employing time domain, frequency domain, and MEer frequency inverted spectral coefficient (MFCC) techniques. These traits are apt to completely depict the evolving nature of cough noises, offering valuable insights for further categorization. Our results reveal that MFCC characteristics are effective in speech categorization tasks and capable of efficiently gathering spectral data from voice signals, which is crucial for differentiating cough sound patterns in COPD and RTI25.

The study employed the Mann-Whitney U test and principal component analysis (PCA) for analyzing data. Utilizing the Mann-Whitney U test, we were able to assess the variance in cough tone traits between the groups (COPD and RTI), especially when the distribution was non-normal. The method's practicality and accuracy in use were established, with the significance test outcomes offering key statistical proof, affirming the practicality of cough tone features in categorizing these two disease varieties26. Furthermore, PCA analysis retains extensive information in its dimensional condensation phase, beneficially enhancing classification models' efficiency and diminishing computational complexity. Post PCA processing, the dimension of the feature gets notably reduced, enhancing the efficiency of the ensuing training of classification models.

Selecting an appropriate machine learning model plays a crucial role in the experimental procedure. The research incorporated two traditional machine learning models, namely random forest and logistic regression. Based on a standard strategy comparing linear interpretable models (LR) and complex nonlinear models (RF), LR and RF were selected to evaluate the trade-off between model complexity and interpretability when distinguishing COPD from RTI using voice features. Experimental findings indicate the efficacy of both models with cough sound data, yet they encounter hurdles, like reduced classification precision in cases of high noise or imbalanced data. Upcoming research might explore the use of integrated learning techniques or intricate deep learning frameworks (like convolutional neural networks and both long and short-term memory networks) to enhance classification effectiveness27.

However, this research is subject to certain constraints. Initially, the limited sample size, encompassing merely 50 patients, could influence the broadly applicable nature of the model. Confirming the model's widespread applicability requires enlarging the sample size eventually to include a broader range of patient populations. Furthermore, despite our proper management of recording and feature extraction, the cough noises in certain patients might not accurately reflect the disease's traits, owing to unique individual variations and disease states. Hence, the future consideration of advanced signal processing techniques, including time-frequency analysis and enhanced feature selection methods, might boost diagnostic precision.

In summary, this research offers an innovative and efficient method for promptly diagnosing COPD and RTI. Cough tone analysis, through the integration of speech signal processing and machine learning techniques, offers new perspectives on categorizing diseases, particularly useful for extensive early screening and non-intrusive diagnosis.
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